
Read Me for Eyewitness Encyclopedia of 
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To move around this file press Page Up and Page Down, or click
in the vertical scroll bar. You can print this file by selecting the Print 
command from the File menu. 

Important: To improve video quality in this product we recommend 
that you set your display to use more than 256 colours. Refer to 
section 4.2 of this Read Me for more information.

Due to the inclusion of the “Find Out More” panel in Nature 2.0, you will find it 
advantageous (particularly with larger monitors) to run the product at a screen 
resolution of 800 x 600 pixels. This will avoid the “Find Out More” panel partly 
obscuring the main Nature 2.0 window. Refer to section 4.1 of this Read Me for 
more information. The product can, however, be run at 640 x 480 pixels, with the 
“Find Out More” panel positioned at whatever location on the screen you find 
most convenient. Refer to section 4.1 of this Read Me for instructions on how to 
change your screen resolution.

This product requires QuickTime for Windows to play videos. If 
videos do not play or if the product will not start, you should reinstall 
the product and install QuickTime for Windows from the CD when 
prompted if you did not do so the first time. If QuickTime is correctly 
installed, refer to section 5 of this Read Me for more information.
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1. Introduction

1.1 About Dorling Kindersley

DK Multimedia titles are available wherever CD-ROMs are sold. New
titles will be available on a regular basis. For more information, 
contact us at DK Multimedia, 9 Henrietta Street, London, WC2E 
8PS.

You may also visit us on the World Wide Web at:

http://www.dk.com

1.2 About this Read Me file



The information in this file is designed to address most of the
problems you may encounter when using any multimedia title. If
you are having problems with Eyewitness Encyclopedia of Nature 
2.0 (Nature 2.0), please take a look at the items listed in the table of 
contents to see if your particular problem is addressed. If you are still
having problems, please call our Technical Support number with:

· details of the problem,
· any error messages that were produced, 
· the full specification of your computer.

If possible, you should be beside your machine when you telephone.

The numbers in London, United Kingdom are:

Telephone: 0171 753 3488
Fax: 0171 753 7575
E-mail: DKMM@DKMM.CO.UK

The numbers in New York, USA are:

Telephone: 1-800 DKMM 575
Fax: 212 213 5240
E-mail: DKMM@phantom.com

More help on making the best use of all the features within
Nature 2.0 is available once you have started the product. Click on 
the help ‘?’ icon located on the left-hand side of the screen. Click on 
'Having Problems?' to access more information (you will also find a 
reminder of some of the main points in this document).

2. CD-ROM problems

2.1 Care of compact discs

Contrary to early reports, compact discs (CDs) are very easily damaged if treated
carelessly. Such damage has a much greater effect on the digital data of a CD-
ROM than on the information of a music CD. A dirty or damaged CD-ROM is 
quite likely to malfunction. With CD-ROM drives becoming ever faster and more 
disc-sensitive, this is an increasing problem.

The surface of the disc can quickly gather dirt and is very easily scratched. To 
protect the data from scratches, finger-prints, dust particles, and smears, do not 
touch the readout side (unlabeled side) of the disc or place it face down on a 
hard surface.



Should the CD become dirty, clean it with a soft cloth lightly moistened with CD 
cleaning fluid or ethyl alcohol, working from the centre to the edge. Do not use 
any type of solvent, such as benzine, lacquer thinner, anti-static agents or LP 
record cleaners as they may damage the surface.

Never leave the disc in a place subject to direct sunlight, high temperature or 
high humidity. Recommended storage conditions are:

· Temperature: 10ºC to 50ºC (50ºF to 122ºF)
· Humidity: 10% to 80%

2.2 Problems with CD-ROM drives

If Nature 2.0 has problems finding the data files it needs from its CD-
ROM, you will see an error message saying that the file, animation 
(ani), or wav can’t be found. Alternatively, you may simply find that 
the screen goes blue with white text and you will get an error 
message saying that there is an error reading drive D. To find what 
has caused the problem, do the following:

1. Check that the Nature 2.0 CD has been correctly inserted into the 
CD-ROM drive.

2. Check that Nature 2.0 is looking in the right place for the CD-ROM
Drive. If, for example, the drive letter has changed as a result of a 
system change, such as adding or removing a RAM disk or 
another device, then Nature 2.0 will fail to find its CD-ROM drive. 

3. If you have an external CD-ROM drive, ensure that it is plugged in,
turned on, and connected to your computer. You may need to 
check the documentation that came with the drive.

4. Verify that your CD-ROM drive is MPC-compatible and double-
speed or faster.

If you have problems with the Nature 2.0 CD vibrating or making a 
strange noise in the drive, then you should contact DK Technical 
Support using the telephone number given at the beginning of this 
file.

If you get an error message saying that there is a problem reading 
the disc, then you should try cleaning the disc and try again. Make 
sure that you restart the product.

3. Setup and Uninstall notes



3.1 Minimum system requirements

In order to run Nature 2.0 you will require a multimedia computer 
with the following minimum requirements:

A multimedia PC, with 486DX/66MHz or higher microprocessor, 8Mb 
RAM (12Mb recommended for Windows 95), MPC-compatible 
double-speed CD-ROM drive and sound card, mouse, SVGA 256 
colour display at 640 x 480 pixels (800 x 600 pixels preferred), 
loudspeakers or headphones, and Microsoft® Windows® version 
3.1x or Windows® 95. 

Nature 2.0 also requires QuickTime™ for Windows, version 2.1.2 If 
you have an earlier version of QuickTime™ for Windows you should 
install version 2.1.2 from the Nature 2.0 CD when prompted.

3.2 How to get started 

1. Insert the disc in the CD-ROM drive.
2. Windows 95 users: the Setup program should start automatically. If it does, 

skip to step 5. If it does not, press Ctrl + Esc, then R, and skip to step 4.
3. Other users: open the Windows Program Manager and choose Run from the 

File menu.
4. In the Command Line box, type d:\setup (where d is the letter of your CD-

ROM drive), then click OK or press Enter.
5. Follow the instructions that appear on your screen.
6.The Setup program creates a program icon in a DK Multimedia program group.
7. Double-click the icon to start the program.

3.3 If Nature 2.0 will not run…

Nature 2.0 requires a sound card to be installed, as all the 
animations in the product are synchronised to run frame-by-frame 
with their accompanying soundtrack. If a sound card is not installed 
Nature 2.0 will not run. You should check that your computer has a 
sound card and drivers installed.

You should also check for the presence of WinG drivers in both the 
Windows and the Windows\system directories. They should only 
exist in the Windows\system directory. If you find any in the 
Windows directory you should delete them. The files to look for are:

wing.dll wing32.dll wingde.dll
wingdib.drv wingpal.wnd



Restart your computer before trying to run Nature 2.0 again.

3.4 If Setup fails with an error message

If the Setup program fails with an error message you should ensure 
that no other programs are running while you try to install Nature 2.0.
You can check this by pressing 'Ctrl + Esc' in Windows 3.1/3.11 or by
pressing 'Alt + Tab' in Windows 95.

3.5 Running Nature 2.0 with Windows 95

3.5.1 Using AutoPlay
If you are running Windowsâ 95, Nature 2.0 can take advantage of 
AutoPlay, which should automatically start the installation procedure 
when you insert the disc into your CD-ROM drive. Nature 2.0 should 
also run automatically when the CD is placed in the CD-ROM drive 
subsequent to the initial Setup. If the installation procedure does not 
start automatically, or the Nature 2.0 program does not automatically 
run when the disc is inserted in the CD-ROM drive, then you can 
check whether AutoPlay is enabled. To do this:

1. Go to the 'Start' menu and choose 'Settings', then 'Control
Panel'.

2. Choose 'System' from the 'Control Panel' to bring up the 'System 
Properties' window.

3. Choose the 'Devices Manager' tab, then select your particular
CD-ROM drive from the CD-ROM device list.

4. Click the 'Settings' tab in this window and ensure that 'Auto
Insert Notification' is checked.

If Auto Insert Notification is checked and Setup does not start 
automatically the first time you insert the Nature 2.0 CD in the drive, 
then you can start the Setup program manually. To do this, go to the 
'Task Bar' and click on 'Start', then 'Run'. Type 'D:\SETUP' in the text
box (where ‘D’ is the letter of your CD-ROM drive). Click 'OK' and 
then follow the instructions that appear on your screen. On 
subsequent occasions the Nature 2.0 program can also be run from 
the ‘Start’ menu by selecting ‘Programs', then ‘DK Multimedia', and 
then by clicking on Eyewitness Encyclopedia of Nature 2.0. You 
should also contact your CD-ROM manufacturer or system supplier 
for the latest Windows 95 compatible drivers.



3.6 Uninstall

The Nature 2.0 CD-ROM contains an Uninstall program which is 
automatically installed in the DK Multimedia program group on 
your computer. If you decide that you no longer wish to have 
Nature 2.0 on your computer, you can use Uninstall to remove it. 
Simply double-click on the ’ Nature 2.0 Uninstall’ icon, then click 
the ‘YES’ button. Uninstall does the rest for you.

If you cannot locate the Uninstall icon and are using Windows 95, 
then you can use the ‘Add/Remove Programs’ wizard. To do this 
click on the ‘Start’ menu on the ‘Task Bar', then select ‘Control 
Panels'. Double-click on the ‘Add/Remove Programs’ icon, then 
select the program you wish to remove from the list. Click on the 
‘Add/Remove’ button and then the ‘Yes’ button.

4. Screen display notes

4.1 Screen resolution

Most DK Multimedia products have been designed to look their best with a 
screen resolution of 640 x 480 pixels, which results in the product’s application 
window completely filling the screen. With Nature 2.0, however, you will find that 
at a screen resolution of 640 x 480 pixels, the Nature 2.0 window will be partly 
obscured by the product’s Find Out More panel. If your monitor and display 
adapter support a screen resolution of 800 x 600 pixels, we recommend that you 
use this resolution for running the product, particularly if you have a large 
monitor. The higher resolution results in a smaller Nature 2.0 window but allows 
the Find Out More panel to be positioned to the side of the main window.

Yet higher resolutions (such as 1024 x 768 pixels) will result in a further reduction
in the size of the Nature 2.0 window. (Note that it is NOT possible to maximise 
the product to fill screens with a resolution higher than 640 x 480 pixels.)

Instructions are given below telling Windows 95 users, and 3.1x users with Cirrus
Logic display adapter cards, how to change to 800 x 600 pixels. All other 3.1x 
users should refer to their display adapter card documentation for instructions 
how to do this:

Windows 95 users
1. From the ‘Start’ menu, choose ‘Settings’ and then ‘Control Panel'.

2. Double-click on the ‘Display’ icon. A ‘Display Properties’ dialog box
will appear.



3. Click on the ‘Settings’ tab.

4. Under ‘Desktop Area', move the slider toward ‘more’ until the 
figures change to ‘800 x 600’. Click the ‘Apply’ button.

Windows 3.1/3.11 users with Cirrus Logic cards
1. In Windows ‘Program Manager', double-click on the ‘VGA Utilities’ 

icon.

2. A ‘VGA Utilities’ program group should appear. It will contain either
a ‘SetRes’ icon or a ‘WinMode Utility’ icon, depending on the type 
of Cirrus Logic card you have. Double-click on this icon. If you do 
not have a ‘VGA Utilities’ icon then you should look for either a 
‘SetRes’ or ‘WinMode’ icon.

3. Select ‘800 x 600’ from the list of available screen resolutions.

4.2 Using more than 256 colours to improve video 
quality

Nature 2.0 is designed to look its best in high colour modes, 
therefore we recommend that you do not set your display driver to 
use less than 256 colours. You can improve the quality of videos in 
Nature 2.0 by setting your display to use more than 256 colours (if 
this is supported by your computer). However, this uses more 
memory and may result in a performance penalty if your display 
adapter is not optimised for high colour modes. If this is the case, 
then we suggest you revert to 256 colours. Instructions explaining 
how to change to more than 256 colours are given below for 
Windows 95 users, and also for Windows 3.1/3.11 users with Cirrus 
Logic and Diamond Stealth video cards. All other users should refer 
to their display adapter documentation for instructions how to do this.

Note: Please write down your display adapter card’s settings before 
you make any changes. That way you will be able to revert to your 
original settings should you need to.

Windows 95 users
1. From the ‘Start’ menu, choose ‘Settings’ and then ‘Control Panel'.

2. Double-click on the ‘Display’ icon. A ‘Display Properties’ dialog box
will appear.

3. Click on the ‘Settings’ tab.



4. Under ‘Colour Palette', choose ‘High Colour (16-bit)'. If your video 
card supports 24-bit colour, then you could select ‘True Colour 
(24-bit)’ instead. This should allow better quality images to be 
displayed. However, should performance be adversely affected, 
we suggest you revert to 256 colours. 

Windows 3.1/3.11 users with Cirrus Logic cards
1. In Windows ‘Program Manager', double-click on the ‘VGA Utilities’ 

icon.

2. A ‘VGA Utilities’ program group should appear. It will contain either
a ‘SetRes’ icon or a ‘WinMode Utility’ icon, depending on the type 
of Cirrus Logic card you have. Double-click on this icon. (If you do 
not have a ‘VGA Utilities’ icon then you should look for either a 
‘SetRes’ or ‘WinMode’ icon.)

3. Select ‘640 x 480’ from the list of available screen resolutions.

4. Select ‘65536’ (16-bit) or 64K/65K (depending on what is 
displayed) from the list of colours available. Alternatively, you 
could select ’16 Million’ (24-bit) if this option is available. 

Windows 3.1/3.11 users with Diamond Stealth cards
1. In Windows ‘Program Manager', double-click ‘Windows

Control Panel’ in the ‘Main’ program group.

2. Double-click the ‘InControl Tools’ Diamond icon.

3. Select the ‘Display’ button to see options for colour depth and then
select 65K high colour mode. Alternatively, you could select a 
higher colour mode if this is available.

If, for any reason, you select an incorrect or unsupported driver:

Windows 3.1/3.11 users
1.Go to the system prompt and change directory to your Windows 

directory by typing 'C:', then press 'ENTER'. 
2.Now type ‘CD C:\WINDOWS'. Press 'ENTER' again, then type 

'SETUP'. 
3.You can now reinstall your original driver.
4.If you did not make a note of your display adapter, and are not sure

what it was, select the VGA driver (not VGA version 3.0.)
5.Contact your machine supplier (or display adapter supplier) to 

obtain updated drivers that will allow you to use more than 256 
colours.



Windows 95 users
1.Start Windows in ‘Safe mode'. Do this by holding down the ‘F8’ key

when the ‘Starting Windows 95’ message appears on the 
screen. 

2.Choose ‘Safe mode’ from the menu. 
3.You can now reinstall your original driver.

4.3 Images appear in monochrome

Some colour display adapters may display Nature 2.0 images in 
black and white. If this happens you should upgrade your display 
driver. Contact the supplier or manufacturer of your display adapter 
to check that you have the latest display drivers.

4.4 Images are truncated

Some display drivers are designed to use large fonts. If your system 
is using one of these, any image in the main window will appear 
slightly truncated. Windows 3.1x users can run the ‘Windows Setup’ 
program to change the default display driver to one that does not 
default to large fonts. Windows 95 users can do this by selecting 
‘Settings’ from the ‘Start’ menu, then by double-clicking on the 
‘Display’ icon. Click on the ‘Settings’ tab, then select a different font 
size from the ‘Font Size’ drop-down list.

5. Problems with the display: animations, video 
and WinG

5.1 General problems

If you get an error message when you try to play animations, you 
may not have the correct motion video drivers installed. During 
Setup, this special system software should have been installed, and 
Windows should have been restarted afterwards to make this 
software work. If you did not restart Windows, do so before 
attempting to run Nature 2.0 again. 

If you are a Windows 3.1x user and videos play jerkily, your system 
may have too little memory available to run video smoothly – on 
machines with only 8MB of memory, restrict the SMARTDRV setting 
that controls the size of the disk cache for use inside Windows to 
512K or less. If you are running Windows 3.1x make sure that the 
SMARTDRV settings in your AUTOEXEC.BAT file enable 



SMARTDRV to cache your CD-ROM drive efficiently. Consult your 
Windows documentation for further information on how to check and 
adjust these settings. You should also try consulting Section 7, 
Running Out Of Memory Or Running Slowly, for further advice. You 
should also check that the CD-ROM is free from dust and dirt, see 
section 2.1, Care of compact discs, for more information.

QuickTime™ for Windows 2.1.2 
This product uses QuickTime™ for Windows 2.1.2 If you cannot play 
video in Nature 2.0 – for example, the opening video will not play – 
then you should check the following:

·  Did you restart your computer after installing Nature 2.0? If you 
did not, do this before trying to run Nature 2.0 again.

·  Did you choose to delete old versions of QuickTime™ for 
Windows when prompted by QuickTime™ Setup? If you did not, 
then you should run the Nature 2.0 Setup program again, and 
when the QuickTime™ Setup starts you should choose to delete 
all old versions of QuickTime™ when prompted. 

·  If you chose not to install QuickTime™ for Windows from the 
Nature 2.0 CD, check that you have QuickTime™ for Windows 
version 2.1.2 or later already installed on your PC. If you do not, 
you should reinstall Nature 2.0, and this time choose to install 
QuickTime™ for Windows from the Nature 2.0 CD. Restart your 
computer before trying to run Nature 2.0 again.

·  Someone may have removed QuickTime™ for Windows from 
your computer. Run the Nature 2.0 Setup program to reinstall 
QuickTime™ for Windows. Restart your computer before trying to 
run Nature 2.0 again.

If video playback is poor quality, or if videos crash (usually caused by
older video drivers), then check the following…

1. Open the Windows ‘Control Panel’
· Windows 3.1/3.11 users: Choose the ‘Main’ program group

in ‘Program Manager', then double-click on ‘Control 
Panels'. 

· Windows 95 users: From the ‘Start’ menu on the ‘Task 
Bar', select ‘Settings', then ‘Control Panels'. If you see two 
QuickTime™ control panels, perform steps 2. to 4. on both 
of them.

2. Double-click on the ‘QuickTime™’ icon to open the ‘QuickTime™ 
Control Panel'.

3. Click the ‘More’ button, then click on the ‘Video’ tab.
4. Click ‘Video Driver’ in the ‘Draw Method’ box, then click ‘Apply'.
5. Restart Nature 2.0.



6. If you still have video playback problems or if the application still 
does not work, repeat steps 1-4 and choose a slower draw 
method (listed in the ‘Draw Method’ box from fastest to slowest). 
You should also ensure that you have installed the latest video 
driver from your computer manufacturer or display adapter 
manufacturer.

If you have problems with videos and sound not synchronising 
properly or if the pitch of sound in videos seems wrong, try the 
following:

1. Open the Windows ‘Control Panel’
· Windows 3.1/3.11 users: Choose the ‘Main’ program group

in ‘Program Manager', then double-click on ‘Control 
Panels'. 

· Windows 95 users: From the ‘Start’ menu on the ‘Task 
Bar', select ‘Settings', then ‘Control Panels'. If you see two 
QuickTime™ control panels, perform steps 2. to 4. on both 
of them.

2. Double-click on the ‘QuickTime™’ icon to open the ‘QuickTime™ 
Control Panel'.

3. Click the ‘More’ button, then click on the ‘Audio’ tab.
4. Check that the ‘Audio Rate Adjustment’ box is NOT checked.
5. Click the ‘Apply’ button.

5.2 Solving problems with animation and video for 
Windows 95 users

If you are running Nature 2.0 under Windows 95 and have problems 
with animation or video (for example, jumpy video, or distorted 
colours), there are three main steps you can try to solve your 
problems. Try the steps in the order given and stop when your 
problem is solved:

5.2.1 Ensuring your display is using 256 colours or more,
5.2.2 Checking your display adapter’s acceleration settings,
5.2.3 Changing your display adapter driver.

5.2.1 Ensuring your display is using 256 colours or more
1. From the ‘Start’ menu, select ‘Settings', then ‘Control Panel'.

2. Double-click on the ‘Display’ icon, then click on the ‘Settings’ tab.

3. Check the ‘Colour Palette’ setting to make sure that it is set to 256 
colours or more.



4. If the setting is less than 256 colours, change it to 256 colours or 
more.

5. Click the ‘Apply’ button, then click ‘OK'.

If this does not solve your problem, or if the setting is already 256 
colours or more, you should try any other available settings over 256 
colours to see if they solve your problem.

5.2.2 Checking your display adapter’s acceleration settings
1.  If you have tried all the available ‘Colour Palette’ settings of 256 

colours or more, and none solve your problem, then you should 
click on the ‘My Computer’ icon using the right-hand mouse 
button, then select ‘Properties'.

2.  In the ‘System Properties’ box you should click on the 
‘Performance’ tab.

3.  In the ‘Advanced Settings’ box, click the ‘Graphics’ button.

4.  In the ‘Advanced Graphics Settings’ box you should move the 
‘Hardware Acceleration’ slide-control down to ‘None', then click 
‘OK'.

5.  If this solves your problem you should try slowly increasing the 
‘Hardware Acceleration’ slide-control until you find the point 
nearest to ‘Full’ at which your problem still remains solved.

6.  If this does not solve your problem, you should put the slider back
to ‘Full' and try the next step.

5.2.3 Changing your display adapter driver
1.  From the ‘Start’ menu, select ‘Settings', then ‘Control Panel'.

2. Double-click on the ‘Display’ icon, then click on the ‘Settings’ tab.

3. Click on the ‘Change Display Type’ button, then on the ‘Change…’ 
button under ‘Adapter Type'.

4. Click on ‘Show Compatible Devices'.

5.  From the list shown, ensure that the driver highlighted is the one 
to match your display adapter. You can check this with your 
computer manufacturer or supplier. 

6. If the driver is not the correct one, you should ask your computer 



manufacturer/supplier to send you one.

In the mean time, or if you already had the correct driver installed, 
you can try installing the generic SVGA driver. 

1. From the ‘Start’ menu, select ‘Settings', then ‘Control Panel'.

2. Double-click on the ‘Display’ icon, then click on the ‘Settings’ tab.

3. Click on the ‘Change Display Type’ button, then on the 
‘Change…’ button under ‘Adapter Type'.

4. Click on ‘Show All Devices'.

5. From the list of manufacturers, choose ‘Standard display types'.

6. In the ‘Models’ list-box, select ‘Super VGA', then click ‘OK'.

If this does not solve your problem, if you have an S3 card, or other 
non-Super VGA compatible card, or if Super VGA was already the 
selected driver, then you should try the Standard display adapter 
(VGA). To select this, use the same procedure as the Super VGA 
adapter, but select ‘Standard display adapter (VGA)’ from the 
‘Models’ list-box.

If either the VGA or SVGA driver solves your problem, this shows 
that it was the original display adapter driver that you had installed 
that was causing the problem. However, the Standard (VGA) display 
adapter does not allow more than 16 colours to be displayed. Since 
Nature 2.0 is designed to look its best in 256 colours or more, the 
long term solution to your problem would be to obtain the most up-to-
date version of the drivers for your display adapter, and check to see 
if they solve your problem – contact your computer manufacturer or 
supplier for these.

5.3 Solving problems with animation, video and WinG 
for Windows 3.1/3.11 users

5.3.1 WinG ( Windows Games Interface) error message
This product uses the WinG Windows Games drivers which are
installed during Setup. The first time you run Nature 2.0, WinG 
‘profiles’ your display for optimum performance. This may take a 
couple of minutes and is only performed once. Certain older video 
display drivers are not compatible with WinG, in which case you may
get the following message when you start the product:



"WinG has encountered a problem with your video display driver.
Contact the manufacturer of your video card to obtain the most
recent driver. Your WinG applications will run, but at reduced
speed."

For best results, we recommend that you obtain and install the most 
recent driver for your video card, although installing the
standard Windows Super VGA 640 x 480 x 256 colour driver works 
on many display adapters. We have included the generic Windows 
Super VGA driver in the SUPPORT directory on the CD-ROM. This 
may be helpful, but we should point out that it is not produced by DK 
Multimedia and is unsupported by us. You may also find that the 
profiling display may crash your system. If you discover this, it is 
normally due to incompatible display drivers. You should try to obtain
the latest display drivers from your display adapter manufacturer or 
computer supplier, or you could also try installing the generic 
Windows Super VGA driver as described above.

Note: Not all display adapter cards are compatible with the SVGA 
driver. We recommend that you make a note of your original driver 
and settings before installing the SVGA driver. Should Windows then
fail to restart you will be able to use Setup in the Windows directory 
to reinstall your original driver.

5.3.2 Installing the Microsoftâ Super VGA Driver
These instructions assume that you have version 3.1 or 3.11 of
Windows and a Super VGA compatible display adapter. If you are 
not sure, please refer to your display adapter documentation or ask 
your computer supplier or manufacturer. 

Note: Before installing the SVGA driver, please make sure that you 
have a backup copy of your original display drivers, in case you 
need to reinstall them later.

1. In Windows 'Program Manager', double-click on 'Windows
Setup' in the 'Main' program group.

2. Select 'Change System Settings..'. from the 'Options' menu.

3. Select 'Other display (Requires disk from OEM)..'. at the bottom of
the 'Display' drop-down list.

4. Type over the 'A:\' and replace it with 'D:\SUPPORT\MSSVGA'
(where D is the letter of your CD-ROM drive).

5. Select 'Super VGA 640 x 480 256 colours' and click 'OK'.



6. Exit Windows and then restart your computer before trying to run 
Nature 2.0 again.

For more information check your Windows documentation, your 
display adapter manual, or contact your supplier.

5.3.3 Problems with video or animations
If you are running Nature 2.0 under Windows 3.1 or 3.11 and have 
display problems (for example, jumpy video or distorted colours) 
there are two main steps you can try in order to solve your problems.
Try the steps in the order given and stop when your problem is 
solved:

5.3.4 Ensuring your display is using 256 colours or more,
5.3.5 Changing your display adapter driver.

However, if you have either a Diamond Stealth 64, Cirrus Logic 
542X, or Cirrus Logic 543X display adapter card, then you should go 
to the sub-section for that particular card and follow the instructions 
that appear there first. If these do not solve your problem, you should
return to this section and follow the instructions given here. If you do 
not know what type of display adapter card you have you can find 
out by doing the following:

1. In Windows ‘Program Manager' double-click on the ‘Main’ program
group icon.

2. Double-click on the ‘Windows Setup’ icon.

3. The text next to ‘Display’ in the window tells you the type of display
adapter you have. You should note this down before changing 
anything.

5.3.4 Ensuring your display is using 256 colours or more
1. Check to see if your display is using 256 colours or more. Since 

the method for doing this varies between display adapters, you 
should refer to your display adapter documentation to do this.

2. If the setting is less than 256 colours, change it 256 colours or 
more. Again, you should refer to your display adapter 
documentation to do this.

3. If this does not solve your problem or if the setting is already 256 
colours or more, you should try any other available settings over 
256 colours to see if they solve the problem.



5.3.5 Changing your display adapter driver
If you have tried all the available ‘Colour Palette’ settings of 256 
colours or more and none solve your problem, then you should try 
changing your display adapter driver.

First check that the correct display adapter driver is installed, as 
described in section 5.3.3. The name of the driver should match the 
name of your display adapter card. If the driver is not the correct one,
then you should ask your computer manufacturer or supplier to send 
you the correct driver. 

In the mean time, you can try installing the generic SVGA driver 
provided on the Nature 2.0 disc to see if this solves your problem. 
Instructions describing how to do this are provided in section 5.3.2.

If this does not solve your problem, if you have an S3 card, or if 
Super VGA was already the installed driver, then you should try 
installing the Standard display adapter (VGA):

1. From Windows ‘Program Manager’ double-click on the ‘Main’ 
program group icon, then double-click on the ‘Windows Setup’ 
icon. Click on the ‘Options’ drop-down menu, then click ‘Change 
System Settings…’

2. From the ‘Display’ list, select ‘VGA', then click ‘OK'.

3. You should get a ‘Change System Settings’ dialog box with the 
message: 

“The driver for this display is already on the system. Do you want 
to use the currently installed driver or install a new driver?”. 

You should click the ‘Current’ button.

4. In the ‘Exit Windows Setup’ dialog box you should click the 
‘Restart Windows’ button.

If either the VGA or SVGA driver solves your problem, this shows 
that it was the original display adapter driver that was causing the 
problem. The standard VGA display adapter does not allow more 
than 16 colours to be displayed. Since Nature 2.0 is designed to look
its best in 256 colours or more, the long term solution to your 
problem would be to obtain the most up-to-date version of the drivers
for your display adapter to see if they solve your problem – contact 
your computer manufacturer or supplier for these.



5.3.6 Diamond Stealth 64 display adapter cards
Windows 3.1/3.11 users who have Diamond Stealth 64 display 
adapter cards and experience any of the following problems…

· Animation ‘shearing’ type effect
· Video profiling crashing altogether
· Animation displaying offset from the correct position on the screen
· Monitor powers down and will not resume

…should follow the instructions below. Try the steps in the order 
given and stop when your problem is solved:

The ideal solution to these problems would be to obtain the latest 
drivers from your computer manufacturer/supplier. For users of 
Diamond Stealth 64 DRAM cards we have included the latest drivers
on the Nature 2.0 CD, and you should try installing these:

1. In Windows ‘Program Manager', double-click on ‘Windows
Setup’ in the ‘Main’ program group.

2. Select ‘Change System Settings...'. from the ‘Options’ menu.

3. Select ‘VGA’ in the ‘Display’ section, then click ‘OK'.

4. A message will appear on the screen

"A driver for this display is already on the system. Do you want to 
use the currently installed driver or install a new driver?". 

You should click ‘Current'.

5. Make sure you exit and restart Windows.

6. In Windows ‘Program Manager', select ‘Run’ from the ‘File’ menu.

7. Type in D:SUPPORT\DIAMOND\INSTALL (where D is the letter of 
your CD-ROM drive). Follow the instructions that appear on your 
screen.

Diamond have built in preference for older programs in their drivers. 
To bypass this, in order for animations and video to work properly in 
many of our programs, you should change the ‘SYSTEM.INI’ file: 

Please note: Editing the system.ini can cause system problems 
if not done properly. We suggest that you take a backup copy of



your system.ini before making any changes, and only proceed 
with making changes if you are sure of what to do.

To edit the ‘SYSTEM.INI’ file:

1. Select ‘File’ in ‘Program Manager', then ‘Run'.

2. Type SYSEDIT in the text box, then press return. Sysedit should 
load. Select ‘SYSTEM.INI’ as the file to edit from the ‘Window’ 
drop-down menu. Select ‘Find’ from the ‘Search’ menu, then type:

[STLTH64.DRV]

then press Enter. If the [STLTH64.DRV]line is highlighted in the
system.ini file, then change the line:

DEVICEBITMAPS=0

to

DEVICEBITMAPS=1

If you get the message “cannot find [STLTH64.DRV]”, you should 
edit the system.ini file by adding the following lines:

(Hold down CTRL + End, this will take you to the end of the file)
(press enter)
[STLTH64.DRV] (now press enter)
DEVICEBITMAPS=1 (now press enter)
(press enter again)

3. When you have finished editing the file, select ‘File’ then ‘Save’ to 
save your changes.

For users with Stealth 64/Diamond Stealth 64 VRAM and Diamond 
Stealth 64 Video VRAM/ Stealth64 Video 3000 series cards, a 
temporary solution may be the use of 65K colour mode or disabling 
the video acceleration option. These can often help solve problems 
with video clips. To change the colour mode:

1. In Windows ‘Program Manager', double-click ‘Windows
Control Panel’ in the ‘Main’ program group.

2. Double-click the ‘InControl Tools’ Diamond icon.

3. Select the ‘Display’ button to see options for colour depth, and



select 65K high colour mode.

4. Click ‘OK’ when you have finished.

To disable the video acceleration option:

1. In Windows ‘Program Manager', double-click ‘Windows
Control Panel’ in the ‘Main’ program group.

2. Double-click the ‘InControl Tools’ Diamond icon.

3. Make sure the box to the right of ‘Disable Video Acceleration’ is 
checked.

4. Click ‘OK’ when you have finished.

(NB: changing your video card driver and restarting Windows
AFTER you've installed Nature 2.0 will result in the WinG 'Profiling' 
display running the first time you restart Nature 2.0. Don't be alarmed
– this only happens once and should not cause any problems.)

5.3.7 Cirrus Logic 542X display adapter cards
Windows 3.1/3.11 users who have Cirrus Logic 542X display adapter
cards, and who experience problems with animations or video, 
should follow the instructions below to install the most up-to-date 
driver. This is provided on the Nature 2.0 CD-ROM. To install the 
driver:

1. In Windows ‘Program Manager', double-click ‘Windows
Setup’ in the ‘Main’ program group.

2. Select ‘Change System Settings...'. from the ‘Options’ menu.

3. Select ‘VGA’ in the ‘Display’ section, then click ‘OK'.

4. A message will appear on the screen:

"A driver for this display is already on the system. Do you want to 
use the currently installed driver or install a new driver?". 

You should click ‘Current'.

5. Make sure you exit and restart Windows.

6. In the Windows ‘Program Manager', select ‘Run’ from the ‘File’
menu.



7. Type in D:\SUPPORT\CIRRUS\INSTALL (where D is the letter of 
your CD-ROM drive).

5.3.8 Cirrus Logic 543X display adapter cards
Windows 3.1/3.11 users who have Cirrus Logic 543X display 
adapters and who experience the following problems:

· Animations and/or videos play with a distorted colour palette
· Animations and/or videos display blurred images or looks like a 

photographic negative.

should follow the instructions below. Try the steps in the order given 
and stop when your problem is solved.

5.3.9 Obtain the latest drivers
The ideal solution to these problems is to obtain the latest drivers 
from your computer manufacturer/supplier. 

5.3.10 Change the colour setting to 64K
1. In ‘Program Manager', double-click on the ‘VGAUtil' program 

group icon.

2. Next double-click on the ‘WinMode’ icon and follow the instructions
that appear on your screen.

3. Select ‘640 x 480’ from the list of available screen resolutions.

4. Select ‘65536’ (16-bit) from the list of colours available. 
Alternatively, you could select ’16 Million’ (24-bit) if this option is 
available, however this may result in a greater performance 
penalty. 

6. Audio problems

6.1 No sound output, but the product otherwise runs 
fine

There are many possible causes of audio problems. For example, 
your computer can only play one sound at a time, so when another 
application is playing a sound, Nature 2.0 cannot do so; you will get 
an error message in these circumstances. Most applications only 
prevent other programs from playing a sound when they themselves 
are doing so, however, some applications, such as certain Screen 
Savers, remove audio capability from all other Windows applications.



If you have such an application, you should turn it off when you are 
running Nature 2.0. 

You should check that the speaker is hooked up to the jack on your 
sound card, and not hooked directly to the CD-ROM drive 
headphone socket. 

During Setup, special system software should be installed, and 
Windows should be restarted afterwards to make this software work. 
If you haven’t already done so, restart Windows now. 

If you cannot hear sound in Nature 2.0, you can test sound in the 
following way:

Windows 95 users
1. From the ‘Start’ menu, select ‘Settings', then ‘Control Panel'.
2. Double-click on the ‘Sounds’ icon.
3. Click on any item with a speaker next to it, then click the ‘Preview’ 

button.

Windows 3.1/3.11 users
1. In ‘Program Manager', choose ‘File', then ‘Run'.
2. Type ‘chimes.wav’ in the text-box, then click ‘OK'.

If you can hear sound, there is some other problem with Nature 2.0. 
If you can’t hear sound, you may not have the correct sound drivers 
installed. Check with your sound card manufacturer to see if you 
have the correct drivers and that there are no hardware conflicts. If 
your sound card came with your computer, call your computer 
supplier.

Some Compaq users running Windows 95 may find that their wave 
volume control is set to zero. This is a known problem for some 
users with Creative Labs, or Ensonic sound drivers, and for Compaq 
users with ESS sound drivers. You can check for this problem by 
looking in your volume control panel to see if your wave volume 
setting is greyed out. The solution to this problem is to get the latest 
Windows 95 compatible audio driver for your sound card from your 
computer or sound card supplier. Users with Ensonic sound cards 
can try using the Ensonic driver supplied on the Nature 2.0 CD-ROM
in the SUPPORT directory. You can also try turning off Nature music 
from Options, located on the left-hand side of the screen.

6.2 Sound decompression drivers

If you encounter the following error message regarding your



sound software, do not worry.

“The sound decompression software is not installed properly or has 
been disabled. For more information see the README file installed 
with this program. This title will now terminate.”

You should first try restarting your computer, and then try to run 
Nature 2.0 again. If this does not solve the problem you should try 
following the instructions given below. Separate instructions are 
given for Windows 95 and Windows 3.1/3.11 users.

Windows 95 users
1. From the ‘Start’ menu, select ‘Settings', and then ‘Control

Panel'.

2. From the ‘Control Panel', double-click on the ‘Multimedia’
icon. The ‘Multimedia Properties’ dialog box should appear.

3. Click on the ‘Advanced’ tab, then click on the ‘+’ sign to
the right of ‘Audio Compression Codecs'.

4. Double-click on the first Codec in the list. The ‘Properties’
dialog box for that Codec should appear.

5. Make sure that ‘Use this audio codec’ is selected. If it is
not, then you should click on the words ‘Use this audio
codec’ to select it. You MUST now click the ‘Apply’ button.

6. Follow the above instructions for each audio codec in the
list.

7. Now reinstall Nature 2.0 then restart your computer before 
attempting to run Nature 2.0 again.

Windows 3.1/3.11 users
1. From the ‘Main’ program group in ‘Program Manager',

double-click on the ‘Control Panel’ icon.

2. Now double-click on the ‘Sound Mapper’ icon. The ‘Sound
Mapper Configuration’ dialog box should appear.

3. Click on the first ‘Sound Mapper’ driver in the list. Now
click the ‘Priority’ button.

4. If the box to the left of the words ‘Disable Driver’ has a
cross in it, you should click it to remove the cross. Then click



‘OK', and then click ‘OK’ again.

5. Follow the above instructions for each Sound Mapper
driver in the list.

6. Now reinstall Nature 2.0 and restart your computer before 
attempting to run Nature 2.0 again.

The following problems may result from running Nature 2.0 without 
the correct sound decompression drivers:

· An error message concerning the sound decompression drivers 
(ADPCM) when you try to run the program.

· Unintelligible sound output from Nature 2.0.
· Speeded up sound in some parts of Nature 2.0 (but not in 

animations).

6.2.1 Solutions for Windows 3.1/3.11 users
If you are running Windows 3.1 or 3.11, to overcome any of these
problems you should:

1. Exit Windows, and in the ‘Windows’ system directory you should 
rename the following files: 'MSACM.DRV' and 'MSADPCM.DRV'.

2. Now restart Windows and run the Setup program for Nature 2.0 
again. Setup will enable the sound decompression drivers to be 
copied from the CD. Once Setup is completed, Windows must be 
restarted to complete the installation procedure. The application 
should now run correctly.

6.2.2 Solutions for Windows 95 users
If you are running Windows 95, to overcome any of these
problems, you should:

1. From the 'Start' menu, choose 'Settings', then 'Control
Panel'.

2. Click the 'Add/Remove Programs' icon. The 'Add/Remove
Programs Properties' dialog box will appear.

3. Select the 'Windows Setup' tab.

4. Highlight the 'Multimedia' option in the list, then select the
'Details' button. The ‘Multimedia’ dialog box will appear.

5. If the 'Audio Compression' box is not checked, you should do



this now. Click 'OK’, then click ‘Apply’. If the drivers are present on
your computer then an update occurs. If the drivers are not 
present you will be asked for your Windows 95 disc. Follow the 
instructions that appear on the screen.

6. If the 'Audio Compression' box is checked, you should click to
deselect it first. Select 'OK’, then click ‘Apply’. Finally, repeat the 
whole operation to re-check the 'Audio Compression' box. This 
ensures that the up-to-date drivers are actually installed by 
Windows 95, and it doesn't just 'think' they are.

If this does not work, you should follow a) below in you are in 
possession of a DK Sampler disc, or b) below if you are not:

a) 1) Insert the Sampler disc into your CD-ROM drive.
    2) Double click on the ‘My Computer’ icon.
    3) Browse the Sampler CD to try and locate the \support\
msacm folder
4) If you can locate the \support\msacm folder, double-click on 
the FIXMSACM.BAT. If you cannot locate the folder, follow b) 
below.

b) Please note, you must have your Windows 95 CD-ROM or disc 
available to complete the steps below:

1) Restart Windows – (MS-DOS Mode)
2) From the DOS prompt, change to the Windows\system 

directory
3) Delete MSACM.* and MSADPCM.ACM from the DOS prompt, 

change to the windows\sysbckup directory
4) Delete MSACM.* and MSADPCM.ACM (If it exists)
5) Type Exit then press the ‘Enter’ key. This will take you 

back into Windows.
6) Insert the windows 95 CD-ROM (Close the auto-run 

Windows 95 program)
7) Run an MSDOS prompt and type:

cd c:\windows\system 

and then (where d is the letter of your CD-ROM drive):

extract d:\win95\win95_08.cab msacm.* 

Next type:

cd c:\Windows\sysbckup



then press the enter key. Next, type:

extract d:\win95\win95_08.cab msacm.* 

Restart your computer, then try to run Nature 2.0 again.

6.3 Audio is fuzzy or distorted

There are a number of possible causes of fuzzy or distorted sounds. 
Problems are often caused by low quality speakers, speakers set to 
high or maximum volume, or speakers powered by batteries that are 
failing. You should also be aware that some speakers are not 
capable of playing low frequency sounds properly. If sound is 
interrupted, this may be caused by low memory – refer to section 7.

Some sound cards have software that allows you to adjust the 
volume AND tone of the sound. If this is the case with your sound 
card, start with these tone controls set in the mid position and your 
volume level set at 50%. This should give a clear signal with no 
distortion. Check your sound card manual for the optimum settings.

Powered speakers are best and, if possible, should be placed either 
side of the screen. You may need to adjust the position of these 
speakers slightly if the magnets in the speakers are unshielded and 
cause discoloration and distortion of the image.

If your CD-ROM drive is not MPC-compatible, then the sound may 
play badly or be interrupted when playing. Check your CD-ROM 
drive’s documentation to ensure that it is a double-speed, or faster, 
CD-ROM drive. If you do have a double-speed CD-ROM drive, and if
you are also a Windows 3.1x user, or a Windows 95 user with no 
‘CDROM’ icon in Device Manager (you can check this by selecting 
‘Control Panels’ from the ‘Start’ menu, and by double-clicking on the 
‘System’ icon. Select the ‘Device Manager’ tab and check to see if a 
‘CDROM’ icon appears in the list), then you should follow the advice 
in about ‘smrtdrv’ in sections 7.1 and 7.2 of this Read Me.

6.4 Sound plays too quietly

Make sure the volume is set to an audible level. Check the sound 
card itself, the speakers or headphones if they have a volume 
control, and any software that may have been supplied with your 
sound card that can change the volume level. If there is a mute 
button in the audio software or on the speaker, check that this is not 
activated.



If the sound controls are set to an audible level, then you could try 
new speakers or headphones to see if they solve the problem.

7. Running out of memory or running slowly

Nature 2.0 uses your computer's system memory to display pictures. 
If you find that Nature 2.0 runs slowly or if you come across out-of-
memory errors, the program probably does not have enough 
memory. Consider doing the following to improve your computer's 
performance:

1. Windows 3.1x users who have machines with only 8MB of 
memory, and Windows 95 users with no ‘CDROM’ icon in Device 
Manager (you can check this by selecting ‘Control Panels’ from 
the ‘Start’ menu, and by double-clicking on the ‘System’ icon. 
Select the ‘Device Manager’ tab and check to see if a ‘CDROM’ 
icon appears in the list), should restrict the SMARTDRV setting 
that controls the size of the disk cache for use inside Windows to 
512K or less. If you are running Windows 3.1x, make sure that the
SMARTDRV settings in your AUTOEXEC.BAT file enable 
SMARTDRV to cache your CD-ROM drive efficiently. Consult your
Windows documentation for further information on how to check 
and adjust these settings. DOS 5.0 does not cache the CD at all – 
users with DOS 5.0 should try upgrading either DOS or 
SMARTDRV for a later version. You can check whether your CD-
ROM drive is cached by going to the DOS prompt and typing 
‘SMARTDRV'. This will show you a list of drives that are cached.

2. Windows 3.1x users should check that 'MSCDEX' which appears 
in the 'AUTOEXEC.BAT’ file is version 2.23 or later, and appears 
before the 'SMARTDRV' entry. You can do this by typing 
'MSCDEX' at the system prompt in MS-DOS. If in no version 
number is given, then you can be sure that your version of 
'MSCDEX' is older than version 2.23. Versions of 'MSCDEX' older 
than 2.23 should be upgraded.

3. Close any unnecessary applications, including any DOS Terminate
and Stay Resident programs (TSRs) you may have installed.

4. If the program is still running slowly, or freezes when you try to 
move to different parts of the program, you can improve its 
performance by selecting the 'Options' screen from within Nature 
2.0 and turning off Nature music, Narrations, and Transitions.

5. Check that your computer has at least 8MB of memory. You can 



do this by leaving Windows, and typing 'MEM' at the system 
prompt. Look for total memory in the Total column. If the figure 
reads 8192Kb or more, then you have at least 8MB of memory. If 
you have less than 8MB (minimum 8192Kb) of memory, then you 
need to install some more.

6. Windows 3.1/3.11 users should check that Windows has 
sufficient memory available for Nature 2.0. Do this by selecting 
'About Program Manager' from the 'Help' menu in ‘Program 
Manager'. The memory available should be a least double the 
amount of your installed RAM. The extra memory here indicates 
the presence of a Windows swap file. You may find more memory 
becomes available if you restart Windows. If you still have less 
than double the amount of your installed RAM this indicates that 
either you have no Windows swap file, or that the swap file is too 
small. If this is the case, you should follow step 5 below. Windows
95 users should ensure that there is plenty of available hard disk 
space to allow the swap file to grow if necessary; at least 20MB is 
recommended.

7. Windows 3.1x users who are running Windows in Enhanced 
mode, set up a permanent Windows swap file on your hard disk of
a least double the amount of your installed RAM. You can do this 
by following the instructions in your Windows documentation.

8. If you are running in colour modes higher than 256 colours (8-bit), 
you should set your display to use 256 colours. Refer to ‘Using 
more than 256 colours to improve video quality‘ in section 4, 
‘Screen Display Notes', for instructions on changing the colour 
mode, but select 256 colours.

9. If you are running DOS 6.0 or higher, then you can run the 
MEMMAKER utility to optimise the memory in your computer. (For
example, if you answer 'No' to the question 'Do you use any 
programs that need Expanded Memory?', MEMMAKER will free 
further conventional memory by inserting the switch NOEMS in 
the appropriate line in your PC's CONFIG.SYS file.) Consult your 
Windows documentation for further information on using 
MEMMAKER.

10.Speed up your hard disk by defragmenting it. There are a number
of tools available to carry out this task, including the 'DEFRAG' 
command found in MS-DOS version 6.0 and later.

8. Printing



Printing screens from Nature 2.0 may take several minutes, 
depending on the type of printer you use. Since screen resolution 
and printer resolution are often different, the printout may not match 
the quality you see on the screen. 

If you are not happy with the position on the page or the size of your 
print out, try using the copy function to copy and paste the picture 
into another application such as a word processor or paint package, 
before printing.

You can change the settings of your printer from within Nature 2.0 by
clicking on the ‘Options’ button on the left-hand side of the screen. 
Click on ‘Print Setup’ to display the ‘Print Setup’ dialog box. (Please 
note: an explanation of the Print Setup dialog box is available in your
Windows documentation.)

Some dot-matrix printers may not print pictures properly with the 
‘Low / Faster’ quality setting in the ‘Print Setup’ dialog box. On these 
printers change the quality setting in the ‘Printer Settings..'. dialog 
box to ‘High / Slower'. Users of dot-matrix printers may also find that 
their print-outs have strange proportions. If this is the case, you 
should ensure that the dpi option is the same for both horizontal and 
vertical settings.

Because the pictures can be quite large, you may have difficulty 
copying or printing in low-memory conditions. In this case, follow the 
advice in section 7 of this file, and try again.

If any of the following printing problems occur:

· Nothing happens after the ‘Printing’ message
· Corrupt output
· Blank paper output

When any of these occur the following steps should be taken, in the 
order given. Stop when your problem is solved.

1. Try printing bitmap pictures from a different application to see if all 
printing is affected. Also make sure that you have the latest driver 
– you should contact your printer manufacturer or vendor to check
this.

2. Try different modes of printing, for example, different print quality 
such as draft, fine, line art. The options available will vary 
depending on the type of printer (check your printer Setup 



documentation for information on how to do this).

Windows 3.1 users
1. Ensure that TEMP is set in the ‘AUTOEXEC.BAT’ file to a valid 

directory, for example, a line in the ‘AUTOEXEC.BAT’ could say 
SET TEMP=C:\WINDOWS\TEMP. This directory must exist and 
there must be room on your hard disk for this ‘temp’ file to be 
created.

2. Check your hard disk with the ‘Scandisk’ program, provided with 
DOS, and choose to repair all errors it flags. Then re-install the 
printer driver.

3. Obtain the most up-to-date printer driver available. Contact your 
printer supplier/manufacturer to do this.

4. Try another compatible printer driver.

5. Change the colour depth used by the screen driver to any setting 
to see if this makes a difference. If this works, then you should 
contact your computer manufacturer/supplier for updated 
print/display drivers. Instructions for some driver types are given in
section 4, Screen Display Notes.

Windows 95 users
Use the Printer Wizard to reinstall your printer. Do this by going to 
the ‘Start’ menu and selecting ‘Settings', then ‘Printers'. Follow the 
instructions that appear on your screen.

9. Connecting to the Internet

Please note: If you would normally pay telephone charges to 
connect to your Internet Service Provider, or for the time that you use
the Internet, these charges will continue to apply while you are using 
the Online feature in this product. You should always ask permission 
from the person who will pay the bill before you use the Online 
feature described below.

If you are able to connect to the Internet from your computer, and if 
you have a Web browser installed, then you can take advantage of 
a feature of Nature 2.0 that lets connect to DK’s Science Online 
Web site. You can also go online to register your product and to visit
the DK’s Web site for information about other DK products, and 
more. If you do not have Internet access, or a Web browser, then 
you will NOT be able to make use of this feature.



Warning: If you are already online and try to connect again, then a 
second, concurrent browser session will be started. Each 
subsequent attempt to connect to go online will start a new, 
concurrent browser session – this is a feature of browsers. Running 
multiple sessions in this way may cause your computer to run out of 
memory and may result in your computer crashing. Therefore, we 
recommend that you run only one browser session at a time.

Connecting to Science Online:
1. Click on the ‘globe’ icon on the right-hand side of the screen. 
2. If an installed Web browser is detected on your machine you will 

see a dialog box with the following message:

“You need to have a Web browser installed to connect to the 
Internet.

Your default Web browser is [name of default Web browser].
Do you want to use this?”

3.  If you select ‘Yes’ then you should be automatically connected to 
the Science Online Web pages. Your Web browser name will be 
stored so that subsequent connections will happen automatically. 
If you select ‘No', or if an installed Web browser was not detected 
on your machine, you will see a dialog box with the following 
message:

“You need to have a Web browser installed to connect to the 
Internet.

If you do not, click on ‘Cancel’ and install your browser first.

See ‘Connecting to the Internet’ in the Read Me file for more 
information.

The Online feature works best if you can locate your Web 
browser. Click on ‘Locate’ to find your browser.”

4. If you’re thinking of clicking ‘Cancel’ because you’re not sure 
where your Web browser is located, you can try looking for it as 
described next:

Windows 95 users
a) Minimise the Nature 2.0 program, then double-click on the 

Start Menu on the Task Bar.
b) Select ‘Find', then ‘Files or Folders'. The ‘Find’ dialog box will 



appear.
c) In the ‘Named’ text field try typing netscape.exe if your 

browser is Netscape Navigator™, or iexplore.exe if your 
browser is Microsoft Internet Explorer™ (Be sure to look for 
iexplore.exe and NOT explore.exe).

d) In the ‘Look in’ field, ensure your hard disk is selected.
e) Next click on the ‘Find Now’ button.
f) The location of your browser will be displayed in a window in 

the lower part of the dialog box.

Windows 3.1/3.11 users:
a) From the Main program group in Windows ‘Program 

Manager', double-click on the ‘File Manager’ icon.
b) In ‘File Manager’ double-click on the drive letter that 

represents your hard drive (this is normally C:).
c) From the ‘File’ drop-down menu, select ‘Search'. The ‘Search’

dialog box will appear.
d) In the ‘Search for’ text field try typing netscape.exe if your 

browser is Netscape Navigator™, or iexplore.exe if your 
browser is Microsoft Internet Explorer™ (Be sure to look for 
iexplore.exe and NOT explore.exe).

e) In the ‘Start from’ field, type C: (where C: is the letter of your 
hard disk).

f) Make sure the ‘Search all subdirectories’ box is checked.
g) Next click on the ‘OK’ button.
h) The location of your browser will be displayed if it is found.

5. If you still don’t know where to locate your browser, but know that 
you have a working Internet connection, you should click ‘Cancel’ 
then exit Nature 2.0 and connect to the Internet in your usual way.
When you restart Nature 2.0 and try to connect to Science Online
again, you will be presented with the dialog shown in step 7, 
stating that this product’s Internet address has been copied to the
clipboard. 

   If you choose ‘Locate’ you will see a ‘Please locate your Web 
browser .exe’ dialog box. You should locate and select the 
executable file of the Web browser that you wish to use, for 
example, netscape.exe or iexplore.exe (NOT explore.exe). Be 
sure that you choose your Web browser .exe, and not another 
application.

6. From the ‘Please locate your Web browser .exe’ dialog box, if you
choose ‘Cancel’ you will see a dialog box with the following 
message:



“This product’s Internet address has been copied to the 
clipboard.

Now connect to the Internet and paste this address into your 
browser.

To set up the browser to be started automatically use the 
‘Online Setup’ button.”

If you wish you can then start your Internet connection in your 
usual way and paste the Science Online Internet address into 
your browser. You can use the Online Setup button to configure 
Nature 2.0 to automatically open your Web browser and take you 
to the appropriate Web page when you click on one of the online 
buttons in the future. 

From the ‘Please locate your Web browser .exe’ dialog box, if you
choose ‘Open’ you will see a dialog box with the following 
message:

“You have selected [name of your selection] as your Web 
browser.

If this does not work, use the ‘Online Setup’ button.”

7. If you choose the ‘Back’ option you will be returned to the ‘Please 
locate your Web browser .exe’ dialog box. If you choose the 
‘Finish’ option you should be connected to the Science Online 
Web page. The name of your Web browser selection will be 
stored for future sessions.

If your connection is not successful check the following:

·  That you can connect to the Internet and use your browser
in the normal way. If you cannot do this, then there is a 
problem with your Internet connection. For example, make 
sure that your modem is correctly connected and switched 
on.

·  Try starting your Internet connection and Web browser 
first, and then start up Nature 2.0 and then try the online 
button.

If you select the wrong .exe, or simply decide that you’d rather use a
different browser from the one you selected, then you can select a 
different browser .exe. You can do this from the Nature 2.0 ‘Online 
Setup’ button. There are two of these: one is located on the main 



menu of the product, and the other is available from within ‘Options’ 
once you have started up Nature 2.0.
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